Release Notes
Axiom Contract Management
Version 2019.3.5




KaufmanHall

5202 Old Orchard Rd. Suite N700
Skokie, IL 60077

(847) 441-8780

(847) 965-3511 (fax)
www.kaufmanhall.com

Support email: support@kaufmanhall.com

Kaufman Hall® is a trademark of Kaufman, Hall & Associates, LLC. Microsoft®, Excel®, and Windows® are
trademarks of Microsoft Corporation in the United States and/or other countries. All other trademarks
are the property of their respective owners.

This document is Kaufman, Hall & Associates, LLC Confidential Information. This document may not be
distributed, copied, photocopied, reproduced, translated, or reduced to any electronic medium or
machine-readable format without the express written consent of Kaufman, Hall & Associates, LLC.

Copyright © 2019 Kaufman, Hall & Associates, LLC. All rights reserved.
Version: 2019.3.5

Updated: 10/31/2019

Release Notes Axiom Contract Management | 2


http://support@kaufmanhall.com/

Contents

SUMIMIAIY 4
Product upgrade NOtes ... 5
New features SUMMaArY .. 6
Map provider names to Org codes ..l 6
Compare G & P line-level APC calculation detail results ... .. ... 7
New payer code option for grouping and pricing and recalculating claims _............................ 9
Shift claim dates for grouping and pricing forecasts . ... .. 10
Improve variance reporting with Posting subcategories ... ... ... 11
Duplicate file check on flat delimited posting files ... .. ... ... 12
Improved import handling of problem files . ... ... L 13
VW IMP Ot IO INE e 14
3M July 152019 APC and eAPG quarterly updaterelease ... .. . ... 15
Issues resolved in 2010.3 . 16
Issues resolved in 2019.3.5 — Axiom Software patch ... ... 17
Manual setup iINStrUCHONS .. 18
KNOWN 1SS U 19

Release Notes Axiom Contract Management | 3



Summary

Kaufman Hall is pleased to announce the 2019.3.5 release of Axiom Contract Management. Each product
release provides new features, enhancements, and configuration options to meet your needs. Many of
these features and enhancements are a direct result of your feedback and suggestions.

Summary of the upgrade process:

1. Review product release notes — Review this document to familiarize yourself with the new
features and functionality.

2. Schedule an installation date — Contact support@kaufmanhall.com or your implementation
consultant, and they will confirm an installation period with you.

3. Complete manual updates — After installing the upgrade, if needed, review any manual setup
steps needed to enable features for this version.

Support

As always, we appreciate your support of Kaufman Hall and look forward to continuing to meet your
financial management needs. If you have any questions about your upgrade, contact Kaufman Hall
Software Client Success at 1-888-543-6833 or support@kaufmanhall.com.

Training

Kaufman Hall offers multiple training options for our clients. These courses are part of your maintenance
agreement and are free of charge. We strongly urge you to take advantage of all training options,
including:

« Self-help videos
+ Recorded webinars
o Virtual training courses

For a complete listing of our courses, please visit www.kaufmanhall.com.
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Product upgrade notes

IMPORTANT: You must apply the Axiom Software 2019.3.5 upgrade before applying any 2019.3.5
Axiom product upgrades. Axiom Software upgrades are backwards compatible so you can upgrade
different products at different times, but you must upgrade to the Axiom Software 2019.3.5 before
the first product upgrade. Refer to the Axiom Software 2019.3.5 Release Notes and Axiom

Healthcare Suite 2019.3 Release Notes for considerations before upgrading.
& J

When upgrading to the 2019.3.5 version of Axiom Contract Management, keep in mind the following:

o This product upgrade contains updated templates, calculation methods, and remediated defects.

o KHA delivered reports may be replaced. Any report that you saved under a different name or
created new will remain untouched. Replaced reports are available in Document History, if
needed.

o Any KHA delivered report that was moved to a new location will automatically move back to its
original location.

o KHA product templates and calculation method libraries will be replaced.

e Product task panes will be replaced.

o Process definitions will not be replaced.

o Driver files will be replaced.

o Security roles and sub-systems will be reset to their configured settings. All user security
exceptions you may have made will remain intact.

o Specificitems configured as part of your company or organization's implementation such as
imports, exports, driver files, and process management files, will remain as is. Any required
modifications to these areas are covered in the release notes, if required.
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New features summary

This section includes a description of the new features in this release.

Map provider names to Org codes

Contract Management administrators can now manage provider name mappings to organizational
codes in their systems using the new Provider Org Code Mapping tool.

When a claim enters the system, the provider name on it is checked against the existing list of names. If
the name is different in any way from the names already in the list (for example, spelling or word order),
it is added to the list. Administrators can then map the new provider names or the name variances to the

correct Org codes.

By default, new provider names come in with the default code. You can select the desired name from the
Org Code drop-down or, if needed, you can create a new Org code.

Provider Org Code Mapping

Warning: Changes to Org Code Mappings will require you reci

Provider Name

AAA AMBULANCE SERVICE

Associates in Medicine

BEN KILDARE SERVICE

CHRIS GOOD HEALTH HOSPITAL - Dikemb
EMERGENCY PHYSICIANS GROUP

GOOD HEALTH HOSPITAL

GREENE

HALL OF FAME MEMORIAL HOSPITAL
HAPPY DOCTORS GROUP PRACTICE

JONES HOSPITAL

Add New Org Code

0rg Code: Description:

To map a provider name to an Org code:

When a unigque provider name
enters the system from a claim, it
is listed here

E3

Org Code

ame

01 KREG MEDICAL CTR ORGT Select the desired Org Code to
map the provider name to

07-KREG MEDICAL CTR ORG1

01 -KREG MEDICAL CTR ORG1 v
03 - CHRIS TEST ORG v
01-KREG MEDICAL CTR ORG1 v
01-KREG MEDICAL CTR ORG1 v
01-KREG MEDICAL CTR ORG1 v
01-KREG MEDICAL CTR ORG1 v
01-KREG MEDICAL CTR ORG1 v
01-KREG MEDICAL CTR ORG1 v

Codes to the selection lists

Use this section to add new OrU

1. Inthe main menu header, from the Admin menu, select Provider Org Code Mapping.

2. Locatethe provider namein the list on the left. Names are listed in alphabetical order.

w

Release Notes
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select the desired Org code. The change is saved automatically. If the needed Org code does not
exist, you can add it using the following instructions.

4. To propagate the provider name and Org code association to existing claims, recalculate the
claims. See “Recalculate a claim” in the online help.

To add a new Org code:

1. Inthe main menu header, from the Admin menu, select Provider Org Code Mapping.

2. Inthe Add New Org Code section, in the Org Code field, type the number to associate with the

Org code.

3. Inthe Description field, type the Org code description.

4, Click Save.

Compare G & P line-level APC calculation detail results

Users running drill-down reports on claims and line items can now include line-level calculation detail
results created from grouping and pricing APCs from any simulation configured for drill-down reporting.
You can now do a side-by-side simulation comparison down to the line-level of detail to compare the
impact of APC schedule changes on a set of claims.

NOTE: Your Axiom Contract Management administrator sets up simulations for drill-down reporting.

Claims and Line-level APC results for up to four simulations at a time

In addition to the Live simulation, up to four simulations can be set up to handle reporting of APC detail
at the claim level. Previous to the 2019.3 release, we only stored grouped and priced APC results from the
Live simulation. In this release, we have extended grouping and pricing to all other simulations. The fields
that are populated on the Claims and Line items tabs are available for the other four simulations selected
for drill-down reporting. This means there are now four new fields for each claim and line level field

currently populated during the group and price process (for example, fields such as PPSPayment, CoPay,

Outlier, etc.).

New Line Item Groupings
added include the APC#
and StatuslIndicator#2-5
as shown in the following
example.

New Line Items Measures
added include the following:

New CMS Measures added
for Claims include the
following:

Release Notes
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Columns
Measures
+ Add New X Delete

Groupings

E-Groupings
. APC

. APC2
-APC3
APC4A
..APCS

..... Batch Number
..... Billl D Mumber

..... EAPG Category
..... EAPG Type

..... Impart Date

..... Line [tem Code
..... Modifier 1

..... Modifier 2

..... Modifier 3

..... Modifier 4

..... RevCaode

..... Service Date 1

..... Service Date 2

..... Service Line Number

..... Status Indicator

..... Statusindicator2
..... Statusindicator3
..... Statusindicatord

..... Statusindicators

..... Unit Type

Columns
Groupings Measures
+ Add New XDele

E-Measures
i L..Charge Amount

..Expected Payment

L...Expected Payment 2
...Expected Payment 3
\..Expected Payment 4

...Expected Payment 5

:.....Nonl:overed Charge Amount
..OPPS EPay CMS
L..OPPS EPay CMS 2
é.....DF‘PS EPay CMS 3
..OPPS EPay CMS 4
..OPPS EPay CMS 5
...DPPS EPay Copay
...DPPS EPay Copay 2
é.....DF'F'S EFay Copay 3
.OPPS EPay Copay 4
5.....DF'F'S EFPay Copay 5
é.....DF'PS Epay Outlier
...OPPS Epay Outlier 2
_OPPS Epay Outlier 3
f.....DF'F'S Epay Outlier 4
_OPPS Epay Outlier 5

To use these new fields in a drill-down report:

Columns

Measures
+ Add New XDelei

Groupings

_..Total Expected Contractual

...Total Expected Payment]
;.....Total Expected Payment2
;.....Total Expected Payment3
E.....Total Expected Payment4
;.....Total Expected Payment5
;.....Total NonCovered Charges
. Total OPPS EPay

i..Total OPPS EPay 2
{..Total OPPS EPay 3
;.....Total OPPS EPay 4

. Total OPPS EPay 5

. Total OPPS EPay CMS

{__Total OPPS EPay CMS 2
__Total OPPS EPay CMS 3
. Total OPPS EPay CMS 4
i Total OPPS EPay CMS 5

...Total OPPS EPay Copay

;.....Total OPPS EPay Copay 2
{__Total OPPS EPay Copay 3
{__Total OPPS EPay Copay 4
{__Total OPPS EPay Copay 5
;.....Total OPPS EPay Outlier

;.....Total OPPS EPay Outlier 2
{__Total OPPS EPay Outlier 3
. Total OPPS EPay Outlier 4

...Total OPPS EPay Outlier 5

i..Total Payments

1. Runan APC group and price against claims in a simulation mapped to drill-down reporting:

a. Ensureyour simulation environment contains the APC contract(s) with the appropriate

Schedule(s).

b. Ensure your simulation environment is mapped to drill-down reporting. You may need to
verify this with the Axiom Contract Management administrator.

c. Group and price the desired set of APC claims for the desired simulation (or simulations, if
you are performing a comparison). For more information, see “Group and price APC and

eAPG claims” in the online help.

2. Create a drill-down report using the desired Claim tab or Line Item tab fields, then add filters to the
report as needed to limit the data included, and then generate the report.
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For more information, see the following in the online help:

e “Build a new drill-down report”

o “Apply filters to a drill-down report”

o “Export a drill-down report”

New payer code option for grouping and pricing and

recalculating claims

Users who group and price and recalculate claims now have the additional option of grouping and pricing
and recalculating by Insurance Plan Code. If a new insurance plan code is added to a version and you
need to group and price related claims or recalculate those claims, you do not have to process all the
claims for that version; instead, you can select to process only the claims that have that specific

insurance plan code.

e m {mport Bata mm ecalcuitions Qe 0 I

Claims 2 | Recalculate Claims | Saved Tasks

Recalculate Claims

Date Type: | Discharge Date v

Start Date: | §/1/2013 ]

End Date: | 8/31/2013 g

Recalculate Create a Saved Task

Select claims by: Patient Account Number Claim Number/UCRN Date Range Contract | @ Insurance Plan Code

Claim Type: | Institutional v
Claim Status: | Live Claims Only v

Ins. Plan Codes:

Current View: ‘ Live

M ‘

KREG MEDICAL CTR ORG1

Expand the desired \

0001

NO DESCRIFTION

001041695

NO DESCRIPTION

0012

NO DESCRIPTION

organization and then select
the desired payer codes

nosa2

NO DESCRIPTION

0106001

NO DESCRIFTION

05535

NO DESCRIPTION

091

NO DESCRIPTION

100000233

NO DESCRIPTION

100000237

NO DESCRIFTION

100000247

NO DESCRIPTION

100301

NO DESCRIPTION

Recalculating selected insurance plan code

For more information, see the following topics in the online help:

e “Group and price APC and eAPG claims”

“Recalculate a claim”

Release Notes
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Shift claim dates for grouping and pricing forecasts

Users who group and price claims for APG and eAPG contracts can shift dates on claims forward in time
to accurately understand the impact of new CMS grouping and pricing logic for the upcoming year.

( IMPORTANT: The shift claim dates feature works only in non-Live simulations. ]

When the new CMS grouping methods and schedules are released, you can get a forecast of how they
will affect your APC and eAPG claims reimbursements by running some of your historical claims through
the grouping and pricing process using the new rules. Normally, grouping logic prevents you from using
future logic against historical claims because they are service-date specific. However, if you shift your
historical claim dates into the next year, you can align your service dates with the 3M logic.

NOTE: You can also shift the dates backward in time by using a negative number of units. You might
do this if you want to know what this year’s claims reimbursements would have paid last year.

The Group and Price Claims page includes a Shift Date By section that remains inactive until you select a
non-Live simulation in which to group and price your claims. You can use the date shift feature for any
claims selection method (Patient Account Number, Claim Number/UCRN, Date Range, etc.) as long as
you select a non-live simulation.

——— mm Ea— fecalculations Queved:0 -
Saved Tasks

Claims 2> | Group and Price Claims

Group and Price Claims

Select claims by: @® Patient Account Number Claim Number/UCRN Date Range Contract Insurance Plan Code

Patient Account # l:l shift Date By (i ]
Claim Status: | Live Claims Only v

To date shift a set of claims for grouping and pricing:
1. Inthe main menu header, click Claims > Group and Price.

2. Onthe Group and Price Claims page, from the Grouping/Pricing Type drop-down, select the
type.

3. Inthe Select claims by section, select an option, For details, see "Group and price APC and eAPG
claims” in the online help.
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4. From the Simulation drop-down, select the desired simulation.

( IMPORTANT: The simulation must not be Live. ]

5. In the first Shift Date By field, click the up or down arrows to select the number of units to shift
the date by.

6. Inthe second Shift Date By field, click the drop-down and select the unit to shift the date by
(Days, Months, Years).

7. Click Group and Price.
8. After grouping and pricing, view the claim voucher report to see the results.

In the following example, the top of the voucher report shows that the service took place in 2013,
but on the bottom, you see that for calculating the expected payment, it used a future Grouper
Schedule, and therefore, a different Grouper Logic.

Simulation: [EPAY3 M Claim Voucher Report
BillD: C921374551|Admission Date: 8/8/2013 Total Charges $1,714.00
Claim Status Active Discharge Date: 8/8/2013 Non-Covered Charges: $0.00
Patient Name: Keefe Weldy |Provision Date: 7/1/2013 to 9/30/2013 Expected Contractual: ($613.64)
Insurance ID: SMID30128 i . Actual Contractual $171.40
Bil Code 151 Provision Jospital Outpatient Hospital Other Expected Payment 52,397 64
Insurance Plan Code: CI012 Contract Name: SMAetna al Medicare Shift Actual Payments $1,542 60
Covered Days 0 . Contractual Variance: ($785.04)
Version # 1 Organization: KREQMEDICAL CTR ORG1 Balance Due: £785.04
TOTAL CLAUSE REIMBURSEMENT $2,327.64
Total Terms Reimbursement $2,327.64
Term #1: ANY/ALL SERVICES $2,327 64
ANY/ALL SERVICES
Calculation ;
Basis: CMS Cutpatient
Payment Summary Information
Medicare Outpatient Schedule: KH MCR 20140701-20140930
Schedule Effective Dates: 711/2014 - 9/30/2014
Services Epay Amount Medicare Portion Patient Portion
APC §£2,914.16 $2,321.80 $592.36
Total Expected Payment $2,914.16 $2,321.80 $592.36

Improve variance reporting with Posting subcategories

Users running drill-down reports on payment and adjustment posting totals can now break out these
items into subcategories for more detailed reporting. In addition to Total Payment and Total Contractual
fields, there are now 10 new payment and 10 new adjustment fields available in the Measures column for
the Claims tab. These new fields allow you to break out payment and adjustment posting totals by type
forimproved contractual variance reporting. You can use these fields to report on refunds, bad debt
adjustments, etc. The new drill-down report fields for adjustments are A1-A10. The new fields for
payments are P1-P10.
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NOTE: To take advantage of this postings breakout feature, you need to provide a posting file with
category breakouts for payments and adjustments imported using Axiom ETL. This import can be in
addition to or part of the Axiom Contract Management Full Import job.

In the example below, adjustment fields A1 and A2 are used to break out primary contractual and facility

adjustments:

A B c D E F G H
X Q axiomsoftware contractual Review
2

3 |Filters
8

SUM SUM Total SUM Total Expected | SUM Total Primary | SUM Total Facility SUM Contractual

9 Contract ClauseDesc Cases Charges Contractual Contractual (A1) Adj (A2) Variance
10 |ALL OTHER OF 31 26,199 2,620 2,620 935 (0)
11 |CARDIOLOGY 3 19,808 1,981 1,500 15 31
12 |[EMERGENCY CARE 54 94,717 9,472 10,472 246 (1,000)
13 |IMAGING SERVICES 30 37,963 3,796 3,291 505 505
14 | IMPLANTS 10 159,460 1,946 2,057 111 (111}
15 |LAB 63 23,744 2,374 2,374 0 0
16 | OBSERVATION 3 22,197 2,220 2,210 10 10
17 [PT/OT/ST 15 8,504 850 1,000 150 (150)
18 |[RADIATION THERAPRY 8 64,505 6,485 6,490 5 (5)
19 |RADIOLOGY SERVICES 5] 2,786 279 279 o (0)
20 |SURGICAL 9 104,189 10,419 15,867 534 (5,448)
21 239 424,073 42,441 48,560 2,515 [6,119)

Duplicate file check on flat delimited posting files

Now you have more transparency into the Axiom Contract Management Full import job process for flat
delimited posting files. When the system encounters a duplicate file, it does the following:

o Date-time stamps the file and copies it to a duplicate file folder under the Imported folder location
from where the file is read. If the folder does not exist, the system creates it.

o Logs the attempt as a duplicate and updates the import report to show that the file was skipped
as a duplicate.
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o Inthe Import Data > Manage Import Batches table, the Notes section records that the file is a
Duplicate and not imported, as shown in the following example:

Import Data >
Manage Import Batches

Select Import Type: [FiatFile mports v|  Filter By: Import Date: Star: [ a/32me || Enc | 992018 |v|

File Location Records Imported Notes
0[ Deimited File Import

Import Date ~

Batch #
09/05/2018 778

0| Deimited File Import

Mas
port\ CPTHCPCF:

port\CPTHCPC Files\

POF\CPTHCPCFiles\

09/03/2019
09/03/2019

PTHCPCSLibrary Update ipt

0| Deimited File Import
AVmportyPostings\Posting3 ot 3

>

Page[ 17 of1 1 ¢<3>

For more information, see “View import activity” in the online help.

Improved import handling of problem files

Users running Axiom Contract Management imports now have greater visibility into what happens to
problem files when claims and remits are read into the system during the Axiom Contract Management
Full Import job. Problem files include duplicate files, files with invalid formats, and files that cannot be

read because of structural or other issues. The new processing enables users to easily locate problem
files and take corrective action.

Previously, most of the information about the reading of EDI claims was reported to the Axiom logs, and

problem files were not easy to find. Now when such problem files occur in imports, the system handles
them as follows:

Duplicate files

The system:

o Date-time stamps and copies the file to a Duplicate file folder under the imported folder location
from which the file is read. If the Duplicate folder does not exist, the system creates it.
e Logsthe attempt as a duplicate

o Inserts the file entry into the TempIimportBatches table without a file hash and with a status of
Duplicate

o Updates the import report to show that the file is a duplicate and was skipped

o Within the system under Import Data, in the Manage Import Batches table, the Notes column lists
the file as Duplicate - Not Imported
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Invalid format files

The system:

o Date-time stamps and copies the file to an Invalid Format file folder under the Imported folder
location from which the file is read. If the folder does not exist, the system creates it.

o Logs the attempt as an invalid format file

o Inserts the file entry into the TemplmportBatches table without a file hash and with a status of
Invalid Format

o Updates the import report to show that the file is an Invalid Format and was skipped

o Within the system under Import Data, in the Manage Import Batches table, the Notes column lists
the file as Invalid Type - Not Imported

Unreadable files

The system:

o Date-time stamps and copies the file to an Unreadable folder under the Imported folder location
from which the file is read. If the Unreadable folder does not exist, the system creates it.

e Logs the attempt as an unreadable file

o Inserts the file entry into the TemplmportBatches table without a file hash and with a status of
Unreadable

o Updates the import report to show that the file is Unreadable and was skipped

o Within the system under Import Data, in the Manage Import Batches table, the Notes column lists
the file as Unreadable - Not Imported

View importer logging

Anew SQL importer log available to administrators provides better visibility into the nightly import
process. The SQL importer log records details about the last import that took place, including any errors,
in an easy-to-view format. Administrators can use this log as a diagnostic tool when errors occur because
it is more descriptive than the Axiom log.

The log records the following:

e SQLImportrun ID number

o Task group ID

o Message — A brief description of the activity during each phase of the process
o Log Date/Time

e Exception —Error and associated information

e Error—Errorflag True or False; True indicates an error
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To view the SQL Importer log:

In the main menu header, click Admin >SQL Importer log.

SQL Importer Log

sQLimporter.. | TaskGrouplD | Message Log Date/Time Exception Error
154 Beginning SQL Importer Job 2019-09-0510:16:08 AM False

1) EXCEPHiON INfOrMation *++ssssrssessssssrmasassssssstssisrissstsnss Exception Type
System.I0.DirectoryNotFoundException Could not find a part of the path
“X:\KregData\EVCMA\Import\CPTHCPCFiles\CPTHCPCSLibraryUpdate.rpt
SACKTraCE INTOMMATION *++HEH AR R A A A AERERERERE Bt
System.I0.__Error. WinlOEror(Int32 errorCode, String maybeFullPath) at
System IO FileStream.Init(String path, FileMode mode, FileAccess access, Int32 rights,
Boolean useRights, FileShare share, Int32 bufferSize, FileOptions options,
SECURITY_ATTRIBUTES secAttrs, String msgPath, Boolean bFromProxy, Baolean
CmaSqlimporterRepository.cs - LoadimportTempTable method - importFile
154 2019-09-05 10:16:08 AM useLongPath, Boolean checkHost) at System.I0.FileStream. ctor(String path, True
X:\KregData\EVCMA\Import\CPTHCPCFiles\CPTHCPCSLibraryUpdate.rpt
FileMode mode, FileAccess access, FileShare share, Int32 bufferSize, FileOptions
options, String msgPath, Boolean bFromProxy, Boolean useLongPath, Boolean
checkHost) at System.I0.StreamReader. ctor(String path, Encoding encoding, Boolean
detectEncodingFromByteOrderMarks, Int32 bufferSize, Boolean checkHost) at
System.|0.StreamReader.ctor(String path, Encoding encoding) at
System 0 File ReadLines(String path) at
Axiom.DAL.CMA CMARepository.ImportWorker.LoadimportTempTable(String
importFile, Int32 taskGrouplD, Int32 sqlimporterRuniD, Boolean forCMAFullimport)
Imported 0 records from
154 2019-09-05 10:16:08 AM False
X:\KregData\EVCMA\IMport\CPTHCPCFiles\CPTHCPCSLibraryUpdate.rpt
Import file: X:\KregData\EVCMA\Import\CPTHCPCFiles\CPTHC PCSLibraryUpdate.rpt
took: 00h:00m:00s:023ms.

2019-09-05 10:16:08 AM False

About to attempt to archive the following files
154 2019-09-05 10:16:08 AM False
X\KregData\EVCMA\IMPOrt\ CPTHCPCFiles\CPTHCPCSLibraryUpdate.rpt

1) EXCEPtion INfOMAtIon FHrehktiokrkbt sk rmerrrbrkr kRt Exception Type:

3M July 15 2019 APC and eAPG quarterly update release

Each quarter, 3M provides an update to the 3M GPS Grouper software integrated into Axiom Contract
Management. This update includes grouping, pricing, and regulatory updates to the APC and State-
specific eAPG groupers.
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Issues resolved in 2019.3

The following table lists the resolutions for issues addressed in 2019.3, released on September 16, 2019:

Issue Description Description

PFB-07682 - PLM - Summary: The user cannot export report results to Excel because the
Reporting error related BilllD field is a display field.

OB RS Resolution: Corrected by removing the BilllD as a display field.

PFB-07787 - CM Group Summary: When using the Group and Price menu selection, selecting a
and Price Error Message payer and a contract provision for the current quarter results in the
There was an error following error message: "The current selections generated an empty
processing the request result set. The recalculation task will be aborted." This message should
[TFS 37763] display only when grouping and pricing or recalculating on parameters

that return zero claims to process.

Resolution: Corrected by updating the WebMethods associated with
Grouping/Pricing and Recalculating to return string values rather than
throwing errors, and by updating the associated typescript files.

PFB-07892 - Special Summary: On the Contract Management View a claim page, when a
Characters in View Claim user includes an underscore in the search box, they receive an error
Window message stating, "Please enter valid search criteria. Only letters,

[TFS 37994] numbers, dashes, commas, and spaces are valid." The claim does come

up when the user searches by name, so the system does accept
underscores but you cannot use them in search fields.

Resolution: Corrected by changing the code to allow using underscore
characters in the account number search field.
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Issues resolved in 2019.3.5 — Axiom
Software patch

The following table lists the resolutions for issues addressed in Axiom Software patch 2019.3.5, released
on November 1, 2019:

Issue Description Description

PFB-07443 - Factors Form - Summary: When a new provision is created by converting

Uncompensated Care and Sole an existing provision, the Uncompensated Care and Sole

Community Fields [40208] Community fields in the Factors form are not being copied
from the source provision to the new provision’s Factors
form.

Resolution: Corrected by adding the missing fields to the
copy function’s stored procedure.

PFB-08122 - CM - Outlier Exclusions in Summary: When a new provision for a Medicare contract is

factors do not copy/import to a new created by converting or importing an existing provision,

provision [40209] any data in the Outlier Exclusions field of the Factors form is
not being copied from the source provision to the new
provision.

Resolution: Corrected by adding the missing field to the
copy function’s stored procedure.

Exporting Version with Summary: When exporting a contract version that uses
SoleCommunityAddon and CMS DRG Factors and has data in the Uncompensated Care
HospitalAcquireConditionAdjustment  and Hospital Acquired Condition Adjustment fields, the
gives error message user receives an error message stating that the file does not
[40268] conform to the system definition for Contracts.

Resolution: Corrected by adding the missing fields to the
export function.

Import Version with Summary: When importing a contract version that uses
SoleCommunityAddon, CMS DRG Factors and has data in the Sole Community
Uncompensated Care, Hospital Addon and the Hospital Acquired Condition Adjustment
Acquired Condition Adjustment and fields, once the version has been imported, these fields,
Outlier Exclusions are blank [40365] and the Outlier Exclusions field are blank.

Resolution: Corrected by updating the schema and stored
procedures to handle the fields that had missing data.
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Manual setup instructions

There are no manual setup or configuration steps required for this release.
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Known issues

The following table lists the known issues for this release:

Issue Description Description

PFB-07236 - Payer Code Symptom: The front screen view for the 835 from a claim contains a

Missing [TFS 32739] detail description of the payer. However, when the user opens the
835, they do not see the same Payer description that is displayed on
the previous screen.

Workaround: Go back to the 835 summary listing report to view the
payer description.

PFB-07168 - C - Line Item Symptom: When the user adds a Line Item Code Plus Revenue Code
Code + Rev Code calc basis Clause to a contract, if the attached rate file has a rate greater than
attach rates routines [TFS $214,000, they receive an error when trying to attach the file. (Error:
36146] On Insert Rates: - SqIDBType.SmallMoney overflow.)

Explanation: Attaching the rate file creates an error.

Workaround: Manually enter the rates.

IMPORTANT: Refer to the Axiom for Healthcare Suite 2019.3 Release Notes for additional known
issues that have a suite-wide impact.
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